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Introduction 
This is the second release of Materials Science on CD-ROM, which 
was originally published in 1996, and is designed for teachers and 
students of materials science, metallurgy, engineering and other related 
disciplines. It contains seven new modules for Windows and Macintosh 
platforms, in addition to the eleven previously released titles. The 
glossary has also been extensively upgraded. 
 
The challenging concepts of this subject area which can be difficult to 
grasp are made easier to understand with this collection of completely 
interactive learning modules, which have been designed to make use of 
those functions best performed by computer. 
 
Materials Science on CD-ROM guides the student through many of the 
key concepts, allowing access to the material at their own pace. By 
employing the highly interactive facilities, students can test their 
understanding, for example, by seeing the consequence of the selection 
of different parameters on graphs and processes. This facility is 
enhanced by graphical animation and hypertext-links between related 
screens and topics. 
 
Designed to complement traditional teaching and learning methods, 
this CD-ROM also serves as a stimulating resource for teachers 
explaining new concepts. For example, the simulations can be 
projected during lectures. 
 
Students learn new aspects of materials science whilst testing their 
knowledge by answering the questions which appear within each 
module on the CD-ROM. Confirmation of correct answers is provided 
in carefully signposted routes through each module. By spending time 
in a “hands on” fashion, students can accelerate their understanding of 
materials science, and later use it for exam revision.  
 
Key words can be clicked on at any time for an immediate definition 
through hypertext links to the glossary. 
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Further questions are provided with fully worked answers in a solutions 
manual available from the publishers. Teachers can thus use the 
modules as the basis for coursework tasks. 
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Guidelines for teaching  
with MATTER modules 

We are still in the early days of interactive computer-aided learning. 
Software has been available for more than thirty years but the hardware 
and software platforms have changed so radically that wide distribution 
has only recently become feasible with the emergence of Windows and 
Macintosh graphical user interfaces. Good practice in the use of 
modern software is therefore only slowly becoming clear. Any 
guidance the MATTER team can give must be preliminary and we must 
not be dogmatic - there is no established dogma! Nevertheless we 
believe that it is worthwhile to outline some of the insights gained from 
the use of software (by us and many others) with undergraduates for the 
past ten years. 
  
Why use software? There are many reasons, among which is the 
potential for improved presentation of difficult concepts, representing a 
gain in quality for both teacher and learner. For the learner the most 
significant advantages are the removal of restrictions on time and place, 
frequency, order and pace of learning. All students do not learn at the 
same rate and the use of software permits a much more student-centred, 
and thus student-controlled, approach. Finally, it is likely that in many 
cases time savings are possible for the teacher. 
 
The MATTER modules have been designed to be multi-purpose - they are 
resources available to both lecturer and student. They can therefore be 
used in a variety of ways, some of which are described in more detail 
below. There are, however, three golden rules to be borne in mind 
when directing students to use the software: 

Support 
The students need initial support in using the material - you may need 
to check that students are familiar with the Windows and/or Macintosh 
user interface, and with the many functions available in all MATTER 
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modules (e.g. notepad, calculator, search, contents page, bookmark, 
back to last page, hotwords, glossary, bibliography ... all detailed 
elsewhere in this User Manual). It may therefore be necessary to run 
one or more introductory sessions with students at their computers. 

Recording 
It is strongly recommended that you urge the students to take notes 
during each session at the computer. Experience shows that learning is 
greatly improved if notes are taken, exactly as they would be at a 
lecture. This can be done using the Notepad facility (subsequently 
saved to a student’s disk), or can be conventionally written on paper. It 
is not the medium which matters, but the act of selection and recording. 

Deadlines 
A further rule is to set work in manageable sections, with relatively 
short deadlines for assessment or feedback. We would not recommend 
an interval longer than two weeks between the setting of a computer-
aided study and its deadline in the form of a piece of coursework to be 
handed in, or a tutorial for discussion and feedback. 

Modes of usage 
There are probably more ways of using MATTER modules than we have 
yet discovered but we already have experience in the following six 
styles. 

Replacement of conventionally taught (lectured) material 
No MATTER module is a self-contained course covering all aspects of its 
subject, aimed at self-contained learning. Each module should be 
viewed as a resource available to both lecturer and student. However, it 
will often prove possible to replace a fraction of the lectures in a course 
with guided use of MATTER modules. The key points associated with 
this way of using the material are those listed as the golden rules above. 
Support should be given to the students before they start, they should 
be encouraged to take notes and they should be given short deadlines 
for submission of some assignment (and subsequently for feedback). 
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Coursework 
It is frequently possible to set short questions which require use of a 
module for their solution. For example, you can use the questions 
which are embedded in each module (which usually appear as a pop-up 
box on the page to which they primarily refer). A list of the questions 
with the page on which they occur and a guide to the answer, is to be 
found in the pages specific to the modules for which you have 
purchased a licence. One stratagem which can be used, is to set an 
assignment with the wording “Answer question number 10 in the 
module Introduction to Phase Diagrams.” Alternatively, questions can 
be included in the locally-modifiable pages to which you as the license 
holder have access. Details of how to modify these pages are to be 
found on page 15. 

Further study 
A major use for MATTER modules is to help the students follow up 
material which has been presented in lectures. They can do this in the 
same way that they might consult a book to elaborate on some aspect of 
the lectured material, or to see it presented in a different way.  It is 
therefore worth including details of the appropriate modules in your 
reading list or recommended bibliography for each course. 

Revision 
It is at revision time that the ready availability of MATTER modules 
becomes particularly useful to students. It might be helpful to the 
students if you were to arrange that all the modules appropriate for each 
year or semester of the course are to be found in one Windows Group 
or Macintosh folder on your network entitled, for example, First 
Semester or Second Semester. 

Tutorials 
MATTER modules are especially helpful in tutorials. If you have a few 
students (up to about five) in your office they can easily cluster round 
the computer screen while you use one or more simulations to provoke 
discussion. It is wise not to be led into a lengthy demonstration of any 
particular simulation since this is better done by the students 
themselves later. 
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Demonstrations in lectures 
The MATTER modules have been designed for use as demonstrations in 
lectures. Many of their pages contain dynamic simulations which 
illustrate concepts much more clearly than a static overhead 
transparency. The magnifier tool is particularly useful for enlarging a 
diagram or animation so that it fills the display screen.  The hardware 
required is an overhead display panel (active matrix TFT so that 
animations are not blurred) or a projector offering the same standards. 
Display at VGA (640 x 480 pixels) is adequate for all MATTER modules. 
If a display panel is used on an overhead projector it is important that 
the projector is sufficiently powerful.  Standard 250W projectors are 
not usually adequate and 400W or greater is needed for most 
projector/room combinations. A low light level is also required and 
therefore curtains or blinds may be needed. 

Hardware issues 
It is worth considering where MATTER modules are going to be used. 
The lecture room, tutorial room and departmental computer cluster are 
fairly obvious locations. However, it is rare that all students in a class 
need simultaneous access to the computers. Apart from an orientation 
session most of the ways in which a lecturer will recommend use of the 
modules will permit students to study them in their own time on their 
own rather than in a group. Students will increasingly own their own 
computer and student single-user licences will be available so that they 
can buy the software in exactly the same way as they would buy any 
recommended course text. 

Lecturer extensions 
There are several ways in which the lecturer can impose his/her own 
style and preferences on the software used by their students. The 
MATTER locally modifiable pages – see pages 18 (PC users) and 39 
(Macintosh users) – can (and preferably should) be customised by the 
license holder. The appropriate MATTER modules, together with other 
relevant software, can be grouped in Windows Groups or Macintosh 
folders so that the student finds the locally-appropriate software 
together in a single place. Assessment packages can be customised (see 
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pages 18 and 39) to reflect those topics which the lecturer feels to be 
important in his/her course. Finally, lecturers who want to author their 
own extension material can avail themselves of the MATTER authoring 
shell and helpline. Indeed we encourage lecturers to contact the MATTER 
office to discuss modifications or new modules which they would like 
to see implemented, with a view to setting up development teams to get 
the necessary modules modified or written. Our address is 

MATTER Project Co-ordinating Office 
Materials Science and Engineering 
University of Liverpool 
Liverpool L69 3BX 
Tel: 0151 794 5006 
Fax: 0151 794 4675 
E-mail: matter@liv.ac.uk 

From this point this Manual diverges into PC and Macintosh versions. 
If you are a PC user, please go to page 7; if you are a Macintosh user, 
please go to page 28. 
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PART I 

For PC Users 
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Details of  
package facilities 

Introduction 
All the MATTER modules have been designed to have a common format, 
so that the student (and lecturer) will not need to learn how each 
module works. This introduction will take you through the feature 
common to each module. In most cases the PC and Macintosh version 
are very similar, however, where a feature is available on only one 
platform or there are differences in the way the feature is implemented, 
this will be indicated. 

Module pages 
Menu pages 
The first page in each module has a series of subjects listed which 
allow the user to select the topic they wish to study. A typical page is 
shown below. When the user selects a module title by clicking on its 
name, the name is highlighted and brief information about the module 

 
Menu page from Introduction to Crystallography 
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appears on the right of the screen. Clicking on the ‘Continue’ button 
takes the user to the first page of that topic. 

Contents pages 
There is a full contents page in each module which allows the user to 
jump from page to page rapidly. A typical contents page is shown 
below; the left hand window lists the sections of the module, and once 
a section is selected, the right hand window lists the pages within that 
section. Double clicking on the name of page takes the user directly to 
that page. 
 

 
Contents page from Deformation of Polymers 
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Preface and summary pages 
At the beginning of each section is a preface page which introduces the 
section, describing the contents of the section, and indicating any other 
sections of the module that the user should have studied before looking 
at the section in question. The final page of the section summarizes the 
section, and reminds the user what they should have learned from the 
section. A typical preface page is shown here. 
 

 
Preface page from Aluminium Alloys: Strengthening 
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Standard pages 
Typical pages from MATTER modules are shown below. In each there 
are six main elements; (i) Text area, (ii) graphic area, (iii) page title, 
(iv) button bar, (v) menu bar, and (iv) a module title. 
 

 
Standard page from Introduction to Point Defects 
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Question & Exercise pages 
Where a page contains an interactive question or exercise a slightly 
different format has been used. A typical exercise page is below. 
 

 
Question and Exercise page from Introduction to Phase 
Diagrams 
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Module facilities and conventions 
All the modules have a standard menu bar and button bar. 

Menu bar 
At all times the menu bar will be present allowing the user to access a 
number of facilities and features. 
 
Menu Item Function 
File Open... 

Quit 
Opens another ToolBook program. 
Closes the current module. 

Edit Undo 
Cut 
Copy 
Paste 
Clear 

Allows text entries to be corrected. 
Allows manipulation of user-interactive fields. 
Allows manipulation of user-interactive fields. 
Allows manipulation of user-interactive fields. 
Allows manipulation of user-interactive fields. 

Tools Magnifier 
 
Bookmark 
Calculator 
Notepad 
Search 

Toggles the ToolBook magnifier function (i.e. if its on it 
gets turned off and vice versa). 
Allows the user to mark a page for later. 
Starts up the standard Windows calculator. 
Starts up the Windows Notepad application. 
Allows a word or phrase to be found in the module. 

Tutorial On 
Off 

Switches into tutorial mode (where available). 
Switches out of tutorial mode (where available). 

Help Glossary 
MATTER 
Tutorial & Help 
Your Tutor’s 
Notes 
About 
MATTER... 

Opens the glossary (at the index page). 
Starts the MATTER on-line help program. 
 
Opens the locally configurable tutor pages, which can 
be used to give information specific to your institution. 
Background Information on the MATTER Project, and 
its staff members. 

 

Button bar 
At all times the user will have access to a button bar which provides the 
standard navigation buttons which allow movement within the module. 
The button bar icons are shown on the next page. At most times all the 
buttons will be accessible, however, in some circumstances one or 
more buttons may be dimmed, indicating that they are not functional at 
that point. 
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Icon Function Description 

 
 Exit module Clicking on this item takes the user out of the current 

module. This key is always available. 

 
Go to contents page Jumps to the module contents screen which allows the 

user to find any page in the module. 

 
 Go to main menu Jumps to the main menu, where the user can select the 

section of the module required. 

 
Go back to last page Allows the user to return to the last page viewed. 

 
Go to previous page Go to the previous page in the module, if the user is at 

the start of a module this jumps to the main menu 
page. 

 
Go to next page Go to the next page in the module, if the user is at the 

end of a module this jumps to the main menu page. 

 
Open glossary Opens the glossary at the index page. 

 
References Gives list of supplementary reading that the user may 

wish to read to expand on the material covered in the 
module. 

 
To make the software as easy to use as possible, we have adopted a 
series of conventions within all the modules. 

Hotwords 
Within the text window, text is usually shown in black, however, when 
a word is shown in blue this indicates that it is a ‘hotword’. If the word 
is blue but not underlined, clicking on that word will take the user to a 
glossary entry which will expand on the meaning of that word. 
Alternatively, a pop-up field might appear giving extra information. If 
the word is blue and is underlined, clicking on the word or phrase will 
take the user to a different part of the module, i.e. away from the 
current page. Clicking on words with dotted underlines results in some 
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form of graphical interaction. (Note. The user can also go to the 
glossary by clicking on the glossary button in the button bar.) 

Pop-up boxes 
There are several ways in which the user may interact with the 
software. When the user is required to select an input from a small 
selection, this may be presented in the form of a pop-up menu. The 
Windows menu will ‘stick’ down when selected until the user makes a 
selection.  

Questions 
These are two distinct types of questions provided within each module. 
(i) Interactive questions and exercises which provide a level of self 
assessment for the student. When the student gives an incorrect answer 
they will be told why it is wrong, and will usually be given the 
opportunity to try again. (ii) There are also a large number of open 
ended questions which the student can call upon which will require 
greater understanding to answer. These are not assessed by the 
computer. The interactive questions and exercise are presented as part 
of the normal flow of the module - the student will encounter these as 
they move from page to page. The open-ended questions are available 
on request (the presence of a large ‘Q’ button indicates to the student 
that there is a question (or questions) available. 

Animations 
In many cases there are animations present which run for extended 
periods of time. In the Windows system the user can stop the animation 
by pressing the ESC key or by holding down the left mouse button. 

Cut and paste 
Where tables of data are generated within a module, the user is able to 
‘cut and paste’ these results so they can be used elsewhere, for instance, 
in the notepad or in a graph plotting program. 

Field colours 
User-interactive objects always appear white on the screen, these 
include text fields that allow the user to copy data, drop-down fields for 
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setting variables and graphical objects that will respond to mouse 
actions. 

Tutorial mode 
Some of the more complex MATTER courseware has two modes of use, 
‘TUTORIAL’ and ‘USER’. The TUTORIAL mode gives the user greater 
guidance in the using the software. For example, when in TUTORIAL 
mode you are given explicit sets of instructions such as what to do next, 
and important points you should observe. It is possible to switch in and 
out of TUTORIAL mode at any time, by selecting the TUTORIAL item from 
the Tools Menu. 

Bookmark 
When you are using a module you may wish to mark a page so that you 
can return to it easily. This is done by using the bookmark feature. This 
is selected from the Tools Menu, you can add (or remove) bookmarks 
at any time. The bookmarks are not preserved between sessions - when 
you leave a module all the current bookmarks are deleted 

Magnifier 
In some situations you may want to zoom in on an area of the screen. 
To do this: Select Magnifier from the Tools Menu, the cursor will 
change to a magnifier glass, click at the point of the screen you want to 
magnify. Scroll bars will appear enabling you to move around the 
screen. To revert to normal size, re-select Magnifier from the Tools 
Menu. 
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 Locally-modifiable  
instructions  

In order to give lecturers, tutors, supervisors, etc. some degree of local 
control as to how MATTER software is used in the context of their 
courses, each module is accompanied by a sister file mmLOCAL, where 
the prefix mm relates to the particular module. For example, 
ELLOCAL.EXE is the locally-modifiable file that can be accessed from the 
module Introduction to Electrons in Crystals. 

Editing the files 
Since these files are not intended for student editing, they are not 
installed with their own Program Manager icons. To run them, open 
File Manager and double-click to open the desired file. The book will 
open at an introduction page, similar to that shown below. 

  
To edit this information, click the cursor anywhere on the green letters. 
The text changes to black on a white background, as shown below. 
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When you have finished editing the information page, click on the Next 
button. This takes you to a blank instruction page, as below. 

  
You can now edit this field as you would any other text editor. Use the 
Text menu to change font face, style, and size. 
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If you run out of space, you can create new pages by selecting New 
Page from the Page menu or pressing Ctrl+N. To delete a page, choose 
Select Page from the Edit menu and then press the Delete button. A 
warning message will appear informing you that the page cannot be 
undeleted. 

Saving changes on a network 
In order to save changes made to the local files, you must have write-
access to disk. If you are running MATTER courseware on a network, 
you may have to consult the network administrator to arrange such 
access.  
 
When you have finished editing, select Save from the File menu. A 
password will be requested to prevent unauthorised users from saving 
the file. Type matter and click OK. 
 
After saving, it is recommended that the file attributes are set to read-
only. 
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Hardware  
specifications 

486 DX2-66 processor or higher. 

8 Mb RAM minimum. 

About 30Mb free hard disc space. 

Double speed CD-ROM drive or faster. 

VGA monitor at 640 480 pixels, 256 colours. 

Windows 3.1 minimum - Windows 95 or higher recommended. 
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Installing from CD-ROM 
on to hard disk 

To install MATTER and its associated files, use the setup program, which 
decompresses the files from the CD-ROM and installs them on your 
hard disk. 

Windows 3.1 
1. Insert the CD-ROM into the drive. 
2. Select Run... from the Program Manager File menu. 
3. In the Command Line box, type d:\setup\setup.exe. (If your CD-

ROM drive uses a different letter, substitute the appropriate letter for 
d:). 

4. Click OK. 

Windows 95 
1. Insert the CD-ROM into the drive. An autorun program will 
automatically appear on your screen (unless the autorun option has 
been disabled).  
2. Select Setup from the menu. 

After copying some temporary files, a dialog box is displayed giving 
you the choice of full installation, custom installation or to quit. 
Custom installation enables you to select which of the MATTER 
components are to be copied to your system and also where to copy the 
Asymetrix ToolBook runtime files that are distributed with the 
software (see below). Unless you are short of disk space, it is 
recommended that you follow the Full installation procedure and install 
to the matter_2 directory (folder). 

MATTER modular files 
Each module of MATTER software comprises two separate .EXE files, 
mm.EXE and mmLOCAL.EXE where the prefix mm indicates the name of 
the module. The main module is contained in mm.EXE, whilst 
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mmLOCAL.EXE is an associated file which can be edited locally, thereby 
allowing course tutors to provide instructions and/or information 
relevant to their particular needs. 
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MATTER file prefix codes 
mm prefix Module title 
XL Introduction to Crystallography 
EL Introduction to Electrons in Crystals 
PO Introduction to Point Defects 
DI Dislocations 
PD Introduction to Phase Diagrams 
TD Thermodynamics of Phase Diagrams 
DF Atomic Diffusion in Metals and Alloys 
NU Nucleation in Metals and Alloys 
EM Introduction to Electron Microscopes 
IM Image Fundamentals 
BS Beam-Specimen Interactions 
SM Using the Scanning Electron Microscope 
AL Aluminium Alloys: Systems 
AS Aluminium Alloys: Strengthening 
AP Aluminium Alloys: Processing 
CO Mechanics of Composite Materials 
PM Deformation of Polymers 
RB Rubber Elasticity 

Core MATTER files 
A number of files are required as central resources by all the individual 
MATTER modules and must be present on your system. These core files 
all have a mat prefix to distinguish them from modular files. 
 
List of core MATTER files 
Core file name Function 
MATACRO.EXE A glossary of materials-related acronyms 
MATGLOSS.EXE The MATTER Glossary 
MATHELP.EXE MATTER Help and Tutorial 
MATTER.EXE A 'splash' screen that displays until the main module is 

opened 
MATTER.SBK A central resource containing shared code 

Asymetrix Multimedia ToolBook 4.0 runtime files 
MATTER software for the PC is developed under the authoring system 
Asymetrix Multimedia ToolBook 4.0, and in order to run, a number of 
ToolBook runtime files must be included. 
 
When SETUP.EXE is run, it determines where to install Multimedia 
ToolBook Runtime. The objective of this process is to avoid installing 
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a duplicate set of runtime files if the files already exist on the user's 
system. SETUP.EXE does this by looking for a file ASYM.INI in the 
Windows directory and, if not found, installs the runtime files in the 
default path and registers the ToolBook version, path and language in 
ASYM.INI. If you already have a version of ToolBook on your system, 
any additional runtime files required by MATTER will be copied to the 
path registered in ASYM.INI. In such cases, the final disk may not be 
required. 
 
Asymetrix Multimedia ToolBook 4.0 runtime files 
TBLOAD.EXE MTB40UTL.DLL MTB40RUN.EXE MTB40RCR.DLL 
MTB40NET.EXE MTB40MM.INI MTB40MM.DLL MTB40LNL.DLL 
MTB40FLT.DLL MTB40CMP.DLL MTB40BMP.DLL MTB40BAS.DLL 
MTB40CBT.DLL CTB40R.SBK TB40DLG.DLL TB40ANM.SBK 
TB40WIN.DLL TB40DOS.DLL   

TrueType fonts 
MATTER software requires TrueType fonts to be enabled on your 
system. If they are not activated, Windows substitutes the closest 
bitmapped fonts available, which produces unacceptable text 
formatting, appearance, etc. 

To check whether TrueType fonts are available: 

1. Open Control Panel from PM group Main. 
2. Select PM item Fonts. 
3. Click on the TrueType... button. 
4. Make sure that TrueType fonts are enabled by checking the first 

box. Windows will be restarted if this setting is changed. 

Windows screen font size 
MATTER software has been designed for display devices using normal 
Windows screen font size. Problems with text handling may occur if 
your display device is running large fonts. 

Network installation 
For file protection to work across a network, the file TB40NET.EXE 
must be stored in a directory in each user’s path statement. 
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When a user tries to access a MATTER file on the network, the file’s 
DOS read-only attribute affects what happens. If a file stored on a 
network is a read-only file and it is opened: 
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• Other users can open the book and copy it, but they cannot delete the 
book, change its file attributes, rename it, or save changes. 

• Other applications may be able to open the file and access 
information, but they cannot change its file attributes, rename the 
file, or save changes. 

 If a file stored on a network is NOT read-only, and it is opened: 

• No other user can open the book, copy it, delete it, rename it, or 
change its file attributes. 

• No other application can modify or access the book, including any 
DOS utilities, Windows applications, or ToolBook applications. 

 
Effect of Read-only attribute on network capabilities 
 Read-only NOT read-only 

Open file Y N 
 

Copy file Y N 
 

Delete file N N 
 

Rename file N N 
 

Save changes to the 
file 

N N 
 

Change file 
attributes 

N N 
 

 
To set a file’s DOS read-only file attribute in Windows, select the 
file in the File Manager, choose Properties from the File menu, 
then specify Read. 
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Running from CD-ROM 
In addition to running the installed software from hard disk or network 
drive, you can also run the software from CD-ROM. Naturally, the 
performance will be a little slower than running from hard disk. 

Windows 3.1 
1. Insert the CD-ROM into the drive. 
2. Select Run... from the Program Manager File menu. 
3. In the Command Line box, type d:\mattercd.exe. (If your CD-ROM 

drive uses a different letter, substitute the appropriate letter for d:). 
4. Click OK. 
5. Alternatively, you can run mattercd.exe from File Manager. 

Windows 95 
1. Insert the CD-ROM into the drive. An autorun program will 

automatically appear on your screen (unless the autorun option has 
been disabled).  

2. Select Run from CD from the menu. 
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PART II 

For Macintosh Users 
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Details of package facilities 
Introduction 
All the MATTER modules have been designed to have a common format, 
so that the student (and lecturer) will not need to learn how each 
module works. This introduction will take you through the feature 
common to each module. In most cases the PC and Mac version are 
very similar, however, where a feature is available on only one 
platform or there are differences in the way the feature is implemented, 
this will be indicated. 

Module pages 
Menu pages 
The first page in each module has a series of subjects listed which 
allow the user to select the topic they wish to study. A typical page is 
shown below. When the user selects a module title by clicking on its 
name, the name is highlighted and brief information about the module 
appears on the right of the screen. Clicking on the ‘Continue’ button 
takes the user to the first page of that topic. 
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Menu page from Introduction to Crystallography 

 

Contents pages 
There is a full contents page in each module which allows the user to 
jump from page to page rapidly. A typical contents page is shown 
below; the left hand window lists the sections of the module, and once 
a section is selected, the right hand window lists the pages within that 
section. Double clicking on the name of page takes the user directly to 
that page. 
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Contents page from Deformation of Polymers 
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Preface and summary pages 
At the beginning of each section is a preface page which introduces the 
section, describing the contents of the section, and indicating any other 
sections of the module that the user should have studied before looking 
at the section in question. The final page of the section summarizes the 
section, and reminds the user what they should have learned from the 
section. A typical preface page is shown here. 
 

 
Preface page from Aluminium Alloys: Strengthening 
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Standard pages 
Typical pages from MATTER modules are shown below. In each there 
are six main elements; (i) Text area, (ii) graphic area, (iii) page title, 
(iv) button bar, (v) menu bar, and (iv) a module title. 
 

 
Standard page from Introduction to Point Defects 
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Question & Exercise pages 
Where a page contains an interactive question or exercise a slightly 
different format has been used. A typical exercise page is below. 
 

 
Question and Exercise page from Introduction to Phase 
Diagrams 

Module facilities and conventions 
All the modules have a standard menu bar and button bar. 

Menu bar 
At all times the menu bar will be present allowing the user to access a 
number of facilities and features. 
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Macintosh Menu Bar 
Menu Item Function 
Apple About MATTER... 

 
Background Information on the MATTER Project, and its 
staff members. 

File Open... 
Run... 
Quit 

Opens another SuperCard stack. 
Opens another application file. 
Closes the current module. 
 

Edit Undo 
Cut 
Copy 
Paste 
Clear 

Allows text entries to be corrected. 
Allows manipulation of user-interactive fields. 
Allows manipulation of user-interactive fields. 
Allows manipulation of user-interactive fields. 
Allows manipulation of user-interactive fields. 
 

Tools Bookmark 
Calculator 
Notepad 
Search 

Allows the user to mark a page for later reference. 
Starts up the standard Macintosh calculator. 
Starts up the Macintosh Notepad application. 
Allows a word or phrase to be found in the module. 
 

Tutorial On 
Off 

Switches into tutorial mode (where available). 
Switches out of tutorial mode (where available). 
 

Help Glossary 
MATTER Tutorial 
& Help 
Your Tutor’s Notes 

Opens the glossary (at the index page) 
Starts the MATTER on line help program. 
 
Opens the locally configurable tutor pages, which can be used 
to give information specific to your institution. 

Button bar 
At all times the user will have access to a button bar which provides the 
standard navigation buttons which allow movement within the module. 
The button bar icons are shown below. At most times all the buttons 
will be accessible, however, in some circumstances one or more button 
may be dimmed indicating that it is not functional at that point. 
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Icon Function Description 

 

Exit module Clicking on this item takes the user out of the current 
module. This key is always available. 

 

Go to contents page Jumps to the module contents screen which allows the 
user to find any page in the module. 

 

Go to main menu Jumps to the main menu, where the user can select the 
section of the module required. 

 

Go back to last page Allows the user to return to the last page viewed. 

 

Go to previous page Go to the previous page in the module, if the user is at 
the start of a module this jumps to the main menu page 

 

Go to next page Go to the next page in the module, if the user is at the 
end of a module this jumps to the main menu page. 

 

Open glossary Opens the glossary at the index page. 

 

References Gives list of supplementary reading that the user may 
wish to read to expand on the material covered in the 
module. 

 
To make the software as easy to use as possible we have adopted a 
series of conventions within all the modules. 

Hotwords 
Within the text window, text is usually shown in black, however, when 
a word is shown in blue this indicates that it is a ‘hotword’. If the word 
is blue but not underlined, clicking on that word will take the user to a 
glossary entry which will expand on the meaning of that word. If the 
word is blue and is underlined, clicking on the word or phrase will take 
the user to a different part of the module, i.e. away from the current 
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page. The user can also go to the glossary by clicking on the glossary 
button in the button bar. 

Pop-up boxes 
There are several ways in which the user may interact with the 
software. When the user is required to select an input from a small 
selection, this may be presented in the form of a pop-up menu. The Mac 
menu requires the user to ‘click and drag’ to select an item .  

Questions 
These are two distinct types of questions provided within each module. 
(i) Interactive questions and exercises which provide a level of self 
assessment for the student. When the student gives an incorrect answer 
they will be told why it is wrong, and will usually be given the 
opportunity to try again. (ii) There are also a large number of open 
ended questions which the student can call upon which will require 
greater understanding to answer. These are not assessed by the 
computer. The interactive questions and exercise are presented as part 
of the normal flow of the module - the student will encounter these as 
they move from page to page. The open-ended questions are available 
on request (the presence of a large ‘Q’ button indicates to the student 
that there is a question (or questions) available. 

Animations 
In many cases there are animations present which run for extended 
periods of time.  

Cut and paste 
Where tables of data are generated within a module, the user is able to 
‘cut and paste’ these results so they can be used elsewhere, for instance, 
in the notepad or in a graph plotting program. 

Field colours 
User-interactive objects always appear white on the screen, these 
include text fields that allow the user to copy data, drop-down fields for 
setting variables and graphical objects that will respond to mouse 
actions. 
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Tutorial mode 
Some of the more complex MATTER courseware has two modes of use, 
‘TUTORIAL’ and ‘USER’. The TUTORIAL mode gives the user greater 
guidance in the using the software. For example, when in TUTORIAL 
mode you are given explicit sets of instructions such as what to do next, 
and important points you should observe. It is possible to switch in and 
out of TUTORIAL mode at any time, by selecting the TUTORIAL item 
from the Tools Menu. 

Bookmark 
When you are using a module you may wish to mark a page so that you 
can return to it easily. This is done by using the bookmark feature. This 
is selected from the Tools Menu, you can add (or remove) bookmarks 
at any time. The bookmarks are not preserved between sessions - when 
you leave a module all the current bookmarks are deleted 

Magnifier 
The Apple System extension CloseView will provide most of the 
functionality of the Magnifier function. Full details of this extension 
can be found in the User Guide that came with your Macintosh 
computer system. 
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Locally-modifiable  
instructions  

There are a set of locally modifiable pages available for each module, 
which will allow you to add information about local resources which 
you feel will be useful to the student while studying a particular 
MATTER module. These resources could include information about 
relevant text books, video, or lecture and practical times. 
 
These files are designated as follows: 

XL (Local) Introduction to Crystallography 
EL (Local) Introduction to Electrons in Crystals 
PO (Local) Introduction to Point Defects 
DI (Local) Dislocations 
PD (Local) Introduction to Phase Diagrams  
TD (Local) Thermodynamics of Phase Diagrams 
DF (Local) Atomic Diffusion in Metals and Alloys 
NU 
(Local) 

Nucleation in Metals and Alloys 

EM 
(Local) 

Introduction to Electron Microscopes 

IM (Local) Image Fundamentals 
BS (Local) Beam-Specimen Interactions 
SM 
(Local) 

Using the Scanning Electron Microscope

AL (Local) Aluminium Alloys: Systems 
AS (Local) Aluminium Alloys: Strengthening 
AP (Local) Aluminium Alloys: Processing 
CO (Local) Mechanics of Composite Materials 
PM 
(Local) 

Deformation of Polymers 

RB (Local) Rubber Elasticity 
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The local help files are accessed by selecting the Your Tutor’s Notes 
from the help menu within each module. The student is able only to 
view these pages, and cannot modify them. To modify the pages the 
academic responsible for the module needs to select the Edit this page 
command from the help menu within the local pages. This will request 
the access password. Once the password matter has been entered, text 
can be added or modified. The page is automatically locked when you 
leave it. The first page shown below, gives contact information so that 
the student knows who to ask for assistance with the software. 
 

 
 

The next page, as shown below, is available to allow you to mention 
local resources which will complement the MATTER software. Further 
pages can be added if necessary by selecting Add another page from 
the Help menu. 
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Hardware  
specifications 

• 68030, 68040 or PowerPC processor (Modules are supplied 
optimised for both 68K and PowerPC systems).  

• System 7.1 or greater.  

• Colour monitor (at least 640x480 pixels, and 256 colours)  

• CD-ROM drive.  

• 8MB RAM minimum.  

• About 40MB free disk space for full installation of all modules with 
help files and Materials Science on CD-ROM glossary. 

 
If the software is to be used from an AppleShare file server, the 
computer should be connected to the server by EtherTalk.  
 
The MATTER modules will NOT run on tradition small-screen 
Macintosh systems. 
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Installing from CD-ROM  
on to hard disk 

To install the MATTER software, simply insert the CD-ROM into the 
drive and drag the ‘MATTER Folder’ icon to any convenient location on 
either a local hard disk or an accessible AppleShare file server. You are 
advised not to move or rename any file or folder within the MATTER 
folder. 
 
The module can be installed on a file server, if you have purchased a 
network licence, provided the person carrying out installation has write 
access to the relevant folder. The software can be successfully run by 
users who only have read access to the folder. 

Running the software 
To run the software, double-click on the Bookshelf icon in the MATTER 
folder. This provides an overview of all the software available. Select 
the module you wish to open, and click the mouse on the Run button. 
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PART III 

The modules 
 


	Introduction
	Guidelines for teaching �with MATTER modules
	Support
	Recording
	Deadlines
	Modes of usage
	Replacement of conventionally taught (lectured) material
	Coursework
	Further study
	Revision
	Tutorials
	Demonstrations in lectures

	Hardware issues
	Lecturer extensions

	Details of �package facilities
	Introduction
	Module pages
	Menu pages
	Contents pages
	Preface and summary pages
	Standard pages
	Question & Exercise pages
	Module facilities and conventions
	Menu bar
	Button bar
	Hotwords
	Pop-up boxes
	Questions
	Animations
	Cut and paste
	Field colours
	Tutorial mode
	Bookmark
	Magnifier


	Locally-modifiable �instructions
	Editing the files
	Saving changes on a network

	Hardware �specifications
	Installing from CD-ROM�on to hard disk
	Windows 3.1
	Windows 95
	MATTER modular files
	Core MATTER files
	Asymetrix Multimedia ToolBook 4.0 runtime files
	TrueType fonts
	Windows screen font size

	Network installation

	Running from CD-ROM
	Windows 3.1
	Windows 95

	Details of package facilities
	Introduction
	Module pages
	Menu pages
	Contents pages
	Preface and summary pages
	Standard pages
	Question & Exercise pages

	Module facilities and conventions
	Menu bar
	Button bar
	Hotwords
	Pop-up boxes
	Questions
	Animations
	Cut and paste
	Field colours
	Tutorial mode
	Bookmark
	Magnifier


	Locally-modifiable �instructions
	Hardware �specifications
	Installing from CD-ROM �on to hard disk
	Running the software


